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Consideraciones Generales

éiQué es MonitorCEC?

MonitorCEC es una aplicacién desarrollada en Matlab® que permite monitorear la
perturbacion de la capa ionosférica de la Tierra ocasionada por la actividad solar, mas
especificamente por las llamaradas solares, fendmeno que emite energia en forma de
rayos-X o energia ultravioleta extrema hacia la Tierra.

El presente documento le guiara durante el proceso de instalacién ademas de realizar una
presentacion basica de la aplicacién, apoyada en ejemplos de cada una de las opciones
ubicadas en el menu del programa.

Contenido del CD
El CD de instalacion de MonitorCEC incluye los siguientes archivos:

e (Carpeta Datos: Carpeta en la que se almacenaran los datos registrados por
MonitorCEC.

e MCR_R2016a_win64_installer.exe: Instalador del Run Time de Matlab 2016a, el
cual contiene el conjunto independiente de bibliotecas compartidas necesarias
para la ejecucién de MonitorCEC.

e MonitorCEC.exe: Ejecutable del programa.
e ManualUsuario.pdf: Este documento de ayuda.

e readme.txt: Archivo de texto con instrucciones para la instalacion y ejecucién del
programa.

e (CodigoFuente.pdf: Documento con los cddigos fuente de la aplicacion.
e splash.png: Imagen de inicio de la aplicacion.

Licencia y Términos de Uso

MonitorCEC es una aplicacion desarrollada por el Grupo de Investigacién en
Astroingenieria Alfa Oridn del Observatorio Astrondmico de la Universidad Tecnoldgica de
Pereira, de uso libre (free software). Se solicita a los usuarios que, en caso de generarse
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publicaciones a partir de los datos registrados haciendo uso de este software, se realicen
las citaciones respectivas.

¢Coémo adquirir MonitorCEC?
MonitorCEC esta disponible para su descarga en la siguiente direccion Web:

https://observatorioastronomico.utp.edu.co/radioastronomia/monitor-cec.html

Por favor lea cuidadosamente la presente guia antes de manipular el programa.
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Guia de Instalacion

Requerimientos Minimos del Sistema

Para el correcto funcionamiento de la aplicacion MonitorCEC, se recomienda que el
sistema cumpla con los siguientes requerimientos minimos:

e Sistema operativo Microsoft Windows® 7 de 64 bits.
e Procesador de 2GHz.
e Memoria RAM de 4GB.

e Espacio en Disco Duro de 500GB.

e Tarjeta de audio de 96000 Hz de entrada de linea.

Instalacion
Para la instalacion de MonitorCEC por favor siga los siguientes pasos:

e Copie todo el contenido del CD o carpeta de instalaciéon en la raiz de la unidad C de
su disco duro.

® FEjecute el archivo MCR_R2016a_win64 installer.exe, el cual contiene el conjunto
independiente de bibliotecas compartidas necesarias para la ejecucion de
MonitorCEC. Debe proporcionar permisos de administrador para esta labor. Siga
las instrucciones que se indican en la ventana desplegada al ejecutar el instalador
hasta finalizar el proceso.

® Ejecute el archivo MonitorCEC.exe y disfrute de la aplicacion.
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Clima Espacial

El Sol, la estrella que da vida al planeta Tierra, se encuentra a 150 millones de kildmetros
de distancia y estd compuesto por hidrogeno y helio, y en un porcentaje minoritario por
mds de 60 elementos, que a causa de las altas temperaturas se encuentran
frecuentemente ionizados. La energia radiante del Sol es generada en su interior, el cual
es sede de una serie ininterrumpida de reacciones termonucleares (Jenkins, 2009).

En la superficie del Sol se presentan una gran cantidad de eventos, y aunque en algunos
casos se desconoce la manera en que se originan (como las manchas solares), si es clara la
forma en que afectan la atmdsfera terrestre y por ende a todos los seres que habitan la
Tierra. El Sol afecta la Tierra de dos modos: el primero esta dado por la radiacién en rayos
X vy ultravioleta extrema (EUV), y el segundo es a través del impacto de materia
desprendida desde el Sol a causa de una eyeccion de masa coronal (CME). Los rayos X y la
radiacion en ultravioleta alteran la ionosfera terrestre, provocando de este modo una
perturbacion en la propagacion de las radioondas que se valen de la reflexion en esta capa
atmosférica para su propagacion. Entre tanto, el flujo de materia solar en la atmdsfera
produce las auroras boreales y australes, cambios en el campo magnético terrestre y
tempestades magnéticas (Jenkins, 2009).

Cuando la propagacién de las radioondas de largo alcance emitidas desde la Tierra se ve
alterada a causa de la actividad solar, se presentan afectaciones de los sistemas de
telecomunicaciones, navegacién, comunicacidn con submarinos, sistemas eléctricos vy
electrdnicos, entre otros. A este conjunto de fendmenos adversos asociados a la actividad
solar se les conoce como Clima Espacial, el cual, dados los impactos sociales y las pérdidas
econdmicas que representa, se constituye como un problema prioritario para la
comunidad internacional (Severe Space Weather Events--Understanding Societal and
Economic Impacts, 2009).

Monitoreo del Clima Espacial

Las llamaradas solares o las explosiones de rayos gamma ocasionan un aumento en la
densidad de ionizacién en la regién D de la iondsfera, por lo cual surge una perturbacion
sibita en ella. Durante uno de estos eventos, el lado de la Tierra que estd siendo
iluminado por el Sol es golpeado por rayos X y por radiacién UV (ultravioleta). Estos
penetran en la capa D, e incrementan el proceso de ionizacién y la densidad de los
electrones, lo cual a su vez incrementard la absorcién de las ondas de radio,
principalmente en los rangos de frecuencia superiores MF (300kHz — 3MHz) e inferiores
HF (3MHz — 30MHz), causando un apagon de radio en todo el planeta. Para las frecuencias
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muy bajas, conocidas como sefales VLF (3kHz — 30kHz) se incrementa el coeficiente de
reflexion, dando lugar a una onda ionosférica mas fuerte (Borgazzi, Lara, Paz, & Raulin,

2014).

Para conveniencia de quienes se dedican al estudio del clima espacial, muchos paises usan
ondas VLF para comunicarse con sus submarinos, pues este tipo de longitudes de onda
puede penetrar el agua. Debido a esto, existen transmisores de dichas frecuencias
distribuidos alrededor del mundo (ver Tabla 1). Las sefiales VLF rebotan en la ionosfera
desde muchos kildmetros de distancia y pueden ser colectadas en casi cualquier lugar
(Borgazzi et al., 2014).

Country Location Name Frecuency (kHz) | Power (kW)
USA Cutler, ME NAA 24.0 1000
Jim Creek, WA NLK 24.8 250
Lualualei, HI NPM 214 566
LaMoure, ND NML 25.2 500
Aquada, Puerto
Rico NAU 40.75 100
Antarctica South Pole VLF 20.0
Australia |\ rt;’%“;‘;t%a*;‘;'; NWC 19.8 1000
] 3SA
China Changde (alternates 3SB) 20.6
3SB
Datonge (alternates 3SA) REED
France Rosnay HWU 209 400
St. Assie FTA 16.8
LeBlanc (NATQ) HWV 21.75
Germany Rhauderfehn DHO 234 500
Iceland | Keflavik (US Navy) NRK 375 100
Keflavic TFK 37.5
India Katabomman VTX3 18.2
Italy Tavolara ICV 20.27 43
Sicily NSC 45.9
Japan Ebino JJl 22.2
Norway Kolsas JXN 16.4 45
Russia Arkhanghelsk UGE 19.7 150 input
Batumi UVA 14.6 100 input
Kaliningrad UGKZ 30.3 100 input
Matotchkinchar UFQE 18.1 100 input
Vladivostok UIK 15.0 100 input
Turkey Bafa TBB 26.7
Hinted Anthom GBZ 19.6 500
Kingdom
Anthom (NATQ) Gab 221 500
London GYA 21.37 120
Fuente: SuperSID Manual.

Tabla 1. Principales estaciones transmisoras en banda VLF alrededor del mundo.
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Los monitores de clima espacial son basicamente receptores de ondas VLF. Cuando se
registra una fulguracion solar dirigida hacia la Tierra, las ondas de radio de baja frecuencia
transmitidas por centros de comunicacidon submarina situados en diversos lugares del
mundo (Tabla 1), son perturbadas por el choque de las llamaradas solares con la ionosfera
terrestre, pudiendo ser captadas desde diferentes puntos de la Tierra. A lo largo del
planeta existe un amplia red de sistemas de monitoreo del clima espacial que registran
permanentemente sefiales VLF terrestres en busca de perturbaciones ionosféricas que
evidencien algun tipo de evento solar. Esta red es administrada por Stanford Solar Center
de Stanford University?, organismo encargado de certificar los diferentes centros de
monitoreo, al igual que de recopilar, almacenar y administrar los datos recibidos por las
estaciones certificadas (Scherrer et al., 2008).

Sistema para el Monitoreo del Clima Espacial de la Universidad Tecnoldgica de
Pereira

Desde el ano 2013, el Grupo de Investigacion en Astroingenieria Alfa Oridén del
Observatorio Astrondmico de la Universidad Tecnoldgica de Pereira inicio el desarrollo de
un sistema para el monitoreo del clima espacial desde Colombia, a partir de la antena, el
receptor electrdnico, y del software desarrollado por Stanford Solar Center (Scherrer et
al., 2008). Sin embargo, dado que este sistema fue ideado considerando las condiciones
de recepcidon de sefiales VLF desde Estados Unidos, fue necesario recurrir a un disefo
propio acorde a las condiciones especificas de Colombia. A partir de la experiencia, se ha
identificado que la senal VLF que se recibe desde Colombia con mejor relacién sefial a
ruido es la emitida en 24kHz por la estacion NAA desde Cutler, Main, Estados Unidos
(primera fila de la Tabla 1). Por esta razon, el sistema construido estad especificamente
adecuado para la recepcion de esta sefal. Como se observa en la Figura 1, el
radiotelescopio desarrollado estd compuesto por una antena tipo lazo rectangular, un
radiorreceptor basado en filtros Butterworth de orden superior, y un software para la
captura, procesamiento, almacenamiento y visualizacién de los datos.

Antena Tipo Lazo Rectangular

Con el fin de adelantar la recepcién de la seiial VLF emitida por la estacion NAA, se
construyo una antena tipo lazo de 2m de lado con 200m de cable aislado calibre AWG22,
enrollados sobre una estructura rectangular de acrilico con 25 vueltas (Figura 2). La sefal
registrada por la antena es transmitida al radiorreceptor a través de un cable coaxial RG59
apantallado, impedancia de 75Q, y una atenuacion de 10dB por cada 100m. En caso de

L http://solar-center.stanford.edu/
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gue el lector desee construir su propia antena, en (Quintero, E. A.; Acuia, A. C.; Puerta, L.
M.; Pulgarin, 2014) se presenta el procedimiento de construccién de la misma.

e T —

Estacion NAA
Sistema de monitoreo SID - UTP

Figura 1. Sistema para el monitoreo del clima espacial desde Colombia, desarrollado por el

Grupo de Investigacién en Astroingenieria Alfa Orién (Quintero, E. A.; Acuiia, A. C.; Puerta
L. M.; Pulgarin, 2014).

Antena Dipolo
construida para 24 KHz

Figura 2. Antena dipolo rectangular del sistema para el monitoreo del clima espacial del

Observatorio Astronémico UTP (Jaramillo, A. E.; Galvis, H. D.; Quintero, 2017).
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Radiorreceptor

El equipo electrénico desarrollado para el acondicionamiento de la sefal recibida por la
antena esta basado en una metodologia generada al interior del Grupo de Investigacion
en Astroingenieria Alfa Orion que posibilita la realizacion en paralelo de filtros analdgicos
activos de orden superior (ver Figura 3). Para el caso particular del sistema de monitoreo
del clima espacial de la Universidad Tecnoldgica de Pereira, se implementé la funcién de
transferencia de un filtro pasa banda de 6° orden con caracteristica Butterworth vy
centrado en la frecuencia de 24kHz (la cual corresponde a la frecuencia de emision de la
estacion NAA). En caso de que el lector desee construir su propio radiorreceptor, en
(Jaramillo, A. E.; Galvis, H. D.; Quintero, 2017) se presenta una descripcion detallada del
proceso de construccién del equipo electrénico en cuestion. Este radiorreceptor posee la
enorme ventaja de que se encuentra especificamente disefiado para la recepcién de
sefiales VLF desde Colombia.

Figura 3. Radiorreceptor del monitor del clima espacial de la Universidad Tecnolégica de

Pereira.
Grupo de Investigacion en Astroingenieria Alfa Orion
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Software

MonitorCEC es una aplicaciéon desarrollada por el Grupo de Investigacion en
Astroingenieria Alfa Orion del Observatorio Astrondmico de la Universidad Tecnoldgica de
Pereira, que permite realizar la captura, procesamiento, almacenamiento y visualizacién
de la sefial suministrada por sistemas para el monitoreo del clima espacial desde
Colombia, que se centran en la sefial emitida en 24kHz por la estacién NAA, la cual es
precisamente la que registra mayor relacion sefial a ruido desde nuestro pais. Para su
operacion, basta simplemente con que el usuario ingrese la sefial arrojada por el
radiorreceptor a través de la linea de entrada de la tarjeta de sonido del computador en el
gue se ejecuta MonitorCEC. Dado que la frecuencia de trabajo es de 24kHz, es necesario
configurar la tarjeta de sonido desde el sistema operativo para que la frecuencia de
muestreo de la linea de entrada se situe en 96000. En caso de que la tarjeta de sonido
embebida en la placa principal del computador no cuente con esta frecuencia de
muestreo, se recomienda adquirir una tarjeta externa que satisfaga esta condicién.
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Presentacion de la Interfaz Grafica

Inicializacion del Software

Una vez ejecutado, MonitorCEC despliega un cuadro de didlogo que permite seleccionar el
dispositivo de entrada de sonido a través del cual el usuario realiza el ingreso de la sefal
arrojada por el radiorreceptor. La Figura 4 presenta esta operacién. Seleccione la opcidn
acorde con su dispositivo y haga click en “Ok”.

"4 MonitorCEC = |l=@] %

Archive Graficar Tools Configutar Ayuda

SdSTES S

Selecione la entrada de sonido

soni 1
SpeakersfHeadphunes (Realtek H\gh Definition Audlu} (Windows DirectSound)

OK ] I Cancel

Esperando Datos

Figura 4. Seleccion del dispositivo de entrada.

En caso de que el usuario seleccione la opcién “Cancelar”, el programa no podra iniciar
con la captura de datos. Puede configurar en cualquier momento el dispositivo de entrada
para la captura de la sefial seleccionando la opcion “Configurar” -> “Seleccionar Entrada
de Audio” (ver Figura 5). Para realizar este ajuste el proceso de captura de datos debe

encontrarse detenido.
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j IH % STF' -|'-r_' .f Seleccionar entrada de audio

Figura 5. Menu de configuracidn de la entrada de audio.

iAdvertencia! Si no selecciona ningun canal de entrada no se activard el boton para
iniciar la aplicacion y se mostrard un mensaje de alerta (ver Figura 6).

4 Alertal =] |

P

o Debe selecionar un canal para poder iniciar la aplicacion

Figura 6. Mensaje de alerta desplegado en caso de que no se seleccione ningln
dispositivo de entrada de datos.

Adquisicion de Datos

Una vez configurado el dispositivo de entrada, se habilita el botdon “Iniciar Proceso”,

cual permite dar inicio a la captura de datos (ver Figura 7).

— O ot

Iniciar Proceso

Figura 7. Boton de inicio de captura de datos.
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Una vez accionado el botdn “Iniciar Proceso”, el software procede con la toma de datos a
razon de 96000 muestras por segundo, durante cinco segundos. Posteriormente,
MonitorCEC calcula la densidad espectral de potencia de esta serie temporal mediante el
algoritmo de Welch (Welch, 1967). Este resultado se visualiza en la ventana principal de la
aplicacion (ver Figura 8), actualizandose cada 5 segundos. Como se observa en esta Figura,
dentro del conjunto de componentes espectrales entre OHz y 50kHz, se identifica
claramente el armdnico en 24kHz, correspondiente a la estacion NAA, el cual presenta en
este ejemplo una potencia de 88.57dB (este valor dependera de la antena construida y del
radiorreceptor utilizado).

A continuacidon, MonitorCEC toma el dato de la densidad espectral de potencia
correspondiente a la frecuencia de 24kHz (88.57dB de la estacion NAA) y lo guarda en un
archivo temporal de Excel denominado Buffer_Actual.xlsx, ubicado en la carpeta Datos.
Este archivo, alimentado por un nuevo valor cada cinco segundos, es supremamente
importante ya que es el que almacena los datos recopilados durante el dia.
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Figura 8. Grafica de la densidad espectral de potencia de la seial recibida. Nétese el
armonico correspondiente a la sefal NAA en 24kHz.
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En ese orden de ideas, en el archivo Buffer_Actual.xIsx la sefial se actualiza y se imprime
cada cinco segundos, lo cual se puede comprobar mediante la barra de progreso ubicada
en la seccion inferior de la ventana principal (ver Figura 9).

2017F-11-21 17:32:30 [16470] NALA=12
|

E
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Fecha Hora [ Datos Actuals de as sefiles

Figura 9. Barra de progreso de la captura de datos.

Para detener la adquisicién de los datos solo basta con dar click en el botén “Detener
Proceso”.

iAdvertencia! Si el archivo Buffer_Actual.xlsx esta abierto, los datos no seran guardados y
serd necesario reiniciar el software. Se recomienda abstenerse de abrir este archivo
mientras MonitorCEC se esté ejecutando. Si es impetuosa la necesidad de abrir este
archivo (porque por ejemplo se desea validar la ocurrencia de un evento solar en las
ultimas horas), se recomienda crear una copia del mismo en una carpeta diferente a la de
trabajo del software, o simplemente utilizar las herramientas de carga de datos y
visualizacidn de graficas incluidas en MonitorCEC y descritas en secciones posteriores.

Salir

Para salir del software asegurese siempre de detener primero la adquisicion de datos
(haciendo click en el boton “Detener Proceso” (ver Figura 10). Para salir de la aplicacion,
accione la “X” presente en la esquina superior derecha de la ventana principal, o ejecute la
accion “Archivo” -> “Salir” (ver Figura 11).

Figura 10. Botdn “Detener Proceso”.
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Figura 11. Menu “Archivo” -> “Salir”.

Al elegir la opcidén de salir de la aplicacion, MoniorCEC desplegarda un mensaje de
confirmacién, como se observa en la Figura 12. En caso de elegir “No”, el sistema retorna

a la ventana principal de la aplicacién y queda lista para iniciar de nuevo con la captura de
datos.
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Figura 12. Mensaje de confirmacion del cierre de la aplicacion.
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Visualizacion de la Sefial en el Dominio del Tiempo

Como se menciond anteriormente, una vez inicializada la captura de datos MonitorCEC
despliega en la ventana principal la densidad espectral de potencia de la sefial registrada.
Esto permite identificar claramente el armdnico correspondiente a la sefial NAA en 24kHz,
lo cual es un indicador simple y directo del correcto funcionamiento del sistema. Ademas,
esta sefial se actualiza cada cinco segundos, por lo cual es posible seguir la evolucion del
componente espectral en cuestidén. Sin embargo, en ocasiones es necesario visualizar la
sefal capturada en el dominio del tiempo, para, por ejemplo, evaluar la evolucién de la
sefial durante un evento solar registrado en algin momento del dia. MonitorCEC permite
cambiar la densidad espectral de potencia visualizada por defecto en la ventana principal
por la grafica de la serie de tiempo registrada. Esta operacién se puede ejecutar
accionando el botén fx presente en la barra superior de herramientas (seccion izquierda
Figura 13), o ejecutando el botén “Graficar” -> “Ver” -> “Sefial Original” (seccion derecha
de la Figura 13). Entre tanto, la Figura 14 presenta una captura de la ventana principal de
MonitorCEC durante la visualizacién de la serie temporal registrada. Para regresar a la
visualizacién de la densidad espectral de potencia, basta simplemente con ejecutar
nuevamente el botdén fx, o seleccionar la opcién “Graficar” -> “Ver” -> “Ver DSP”
disponible en la barra de menu.

g R -
Archivo Graficar Took Confiqurar Ayuda ~ Archivo Tools  Configurar ~ Ayuda
AU e & Cargar Gréfica :3
Ver b Senal Original

Ver D3P

| Manturar Imanan ] | Cantirar Imse T

Ver senal anginal/D5P

Figura 13. Visualizacion de la sefial registrada en el dominio del tiempo.

Almacenamiento de Datos

Como se menciond anteriormente, la densidad espectral de potencia en dB
correspondiente a la sefial NAA en 24kHz es almacenada en el archivo Buffer_Actual.xlsx
cada cinco segundos. Al finalizar el dia en el tiempo universal, es decir, a las 00:00:00H UT
(19:00:00H de Colombia), el software almacenara los datos recopilados durante todo el
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dia en un nuevo archivo de Excel con el nombre UTP_NAA_AAAA_MM_DD, donde
AAAA_MM_DD corresponde al afio, mes y dia del registro, respectivamente. A
continuacion, MonitorCEC reinicia el archivo Buffer_Actual.xIsx para de esta manera
proceder con el almacenamiento de los datos del nuevo dia. Todos los archivos generados
por el software son almacenados en la carpeta “Datos” dentro de la carpeta de
instalacidn. La Figura 15 presenta una captura del contenido de esta carpeta. Como se
observa, ademas del buffer actual, se identifican también los archivos correspondientes a
los datos registrados durante 10 dias del mes de noviembre de 2017.

Archive  Graficar  Tools  Ayuda

RS L

0.2 T T T T T T T

Samples «10%

2017-11-28 20:51:55 [1343] NAA=83

Figura 14. Visualizacion de la sefal en el dominio del tiempo.

Visualizacion de Sefiales Almacenadas

MonitorCEC permite cargar y visualizar las sefiales almacenadas en la carpeta “Datos”, ya
sea el buffer actual, o los diferentes archivos que se generan dia tras dia. Para graficar
estas sefiales es necesario ejecutar la opcién “Graficar” -> “Cargar Grafica”, disponible en
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la barra de menu (ver Figura 16). Al accionar este botdn, la interfaz desplegara el cuadro
de didlogo abrir, el cual le permitira seleccionar el archivo de Excel de interés.

Nombre

7 Bufer Actual

B5UTP_NAA_2017-11-10
G5 UTP_NAA 2017-T1-11
7 UTPNAR 20171112
7UTPNAA 2017-11-13
A UTP_NAA 20171114
47UTPNAR 2017-11-15
G5 UTPNAR 2017-11-16
85 UTP_NAA_2017-11-17
G5UTP_NAA 2017-11-18
G7UTPNAA 2017-11-19
B5UTPNAA 2017-11-20

= Unidad de USB )

 Uridad de USE (E)

o Red
= rros

4 Grupo en 2l hogar

Archivo Tools  Configurar  Ayuda

L

j H Cargar Grafica @

Ver b

Figura 16. Opcidn para la carga de seiiales almacenadas en la carpeta “Datos”.
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La Figura 17 presenta una captura de la visualizacién de una senal de ejemplo. Nétese que
la grafica presenta dos regiones, una en color amarillo y otra en color azul. La primera
tonalidad identifica la seccion de la grafica que corresponde al dia local, mientras que el
tono azul representa la sefal registrada durante la noche. Esta diferenciacion es
importante ya que las perturbaciones en la iondsfera solo son visibles en las sefiales VLF
durante las horas del dia. La Figura 17 también permite observar el eje horizontal
correspondiente a la hora local, y el eje vertical que representa la intensidad de sefial en
dB.

ASO9E|0E

%108

Power Spectrum(dB)

Time GMT-5

Figura 17. Visualizacion de una sefial del archivo disponible en la carpeta datos.

Notese que la region correspondiente a la sefial recibida durante el dia (color amarillo de
la Figura 17), presenta un patrén propio de una curva suave. Cuando se presenta un
evento solar, esta continuidad es interrumpida de manera subita. Por ejemplo, la Figura
18 presenta la sefial registrada para el dia 14 de mayo de 2016, fecha en la que se
presentaron dos eventos de intensidades C7.4 y C4.8, a las 5:50H y a las 9:30H,
respectivamente.
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Figura 18. Eventos solares tipo C registrados el 14 de mayo de 2016 desde el OAUTP.

Almacenamiento de Imagenes

Las graficas visualizadas por la aplicacion MonitorCEC, ya sea en la ventana principal
(densidad espectral de potencia o sefal en el tiempo) o en ventanas auxiliares (sefiales
cargadas mediante la opcidon “Cargar) pueden ser almacenadas en el disco duro del
computador. Para esto utilice la opcidn “Archivo” -> “Guardar” para las graficas
visualizadas en la ventana principal de la aplicacion (ver Figura 19), o la opcién “File” ->
“Save” para las gréaficas visualizadas en ventanas auxiliares. Una vez realizado este
proceso, la aplicacion desplegard el cuadro de didlogo “Guardar” (ver Figura 20).
Seleccione la carpeta de almacenamiento para el archivo, establezca un nombre para el
mismo, y elija el formato de preferencia.
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Figura 19. Opcidn grabar imagen en archivo .jpg.
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Figura 20. Cuadro de didlogo para el almacenamiento de graficas.

Opciones de Zoom
MonitorCEC permite realizar ampliaciones a regiones especificas de las graficas

seleccionadas por el usuario. Para utilizar esta opcién haga click en el icono K presente
en la barra de herramientas, o haga click en la opcién “Tools” -> “Zoom” (Figura 21).
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Figura 21. Seleccion de la herramienta de ampliacién de graficas.

A continuacidén, seleccione con click sostenido la regién dentro de la gréfica que sea
ampliar, tal como se observa en la Figura 22.
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Figura 22. Seleccidn de la region de la grafica a ampliar.
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Al liberar el botén del mouse, una vez seleccionada la regién de interés, MonitorCEC
realizard la ampliacién correspondiente en la misma ventana de trabajo (ver Figura 23).
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Figura 23. Ampliacién de la regién seleccionada en la Figura 22.

Para reestablecer la escala de visualizacién al valor original, basta con hacer click derecho
sobre la grafica y seleccionar la opcion “Reset to Original View”. También es posible

reducir la ampliacién de manera gradual seleccionando el icono Q presente en la barra
de tareas, y haciendo click sobre la grafica hasta disminuir la ampliacién al valor deseado
(ver Figura 24).

Archive Graficar Teeols Configurar  Ayuda

gl /AT EE | S

Zoom Qut

Figura 24. Herramienta para la reduccién gradual de la escala en imagenes ampliadas
previamente.
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Herramienta de Desplazamiento
Una vez se ha realizado una ampliacién sobre la grafica visualizada, es posible moverse

sobre la imagen conservando el nivel de zoom. Para esto, seleccione el icono V] presente
en la barra de herramientas, y con click sostenido mueva la imagen a su gusto. Para el
caso de las graficas presentadas en la ventana principal de la aplicacion, también es
posible realizar este proceso seleccionando la opcidn “Tools”->"Mover” de la barra de
menus (ver Figura 25).

Archivo  Graficar Tncllsl Configurar  Ayuda Archivo Graficar Tools Configurar  Ayuda
5 d g Mover o | % R -k: f @
Zoom
| Cursor , :
it S i B | {-antirar Imanan |

Figura 25. Herramienta para desplazar la imagen ampliada.

Cursores

MonitorCEC permite desplegar un cursor que hace posible conocer el instante de tiempo y
el valor de sefial de un punto dado sobre la grafica. Para seleccionar esta opcion haga click
sobre el icono presente en la barra de herramientas, o, para el caso de las graficas
desplegadas en la ventana principal, seleccione la opcion “Tools”->"Mover” en la barra de
menus (ver Figura 26). A continuacién, haga click sobre el punto de la grafica que desea
conocer. MonitorCEC desplegard un pequeiio recuadro con los valores que identifican el
punto seleccionado, tal como se observa en la Figura 27.
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Figura 26. Seleccion del cursor en MonitorCEC.
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Figura 27. Visualizacion de las coordenadas del punto seleccionado mediante el cursor.

Para crear un nuevo cursor, basta con hacer click derecho sobre la grafica y seleccionar la
opcion “Create New Datatip”. A continuacion se hace click sobre el nuevo punto de
interés, y MonitorCEC desplegara una nueva ventana pequefia con las coordenadas del
ultimo punto seleccionado. Estos pasos se ilustran en las Figuras 28 y 29. Para eliminar el
ultimo cursor agregado, basta con dar click derecho en la imagen y seleccionar la opcién
“Delete Current Datatips”. Para eliminar todos los cursores agregados, haga click derecho
en laimagen y seleccione la opcién “Delete All Datatips”.
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Figura 29. Visualizacion de las coordenadas de tres puntos sobre la grafica mediante la
opcién de cursores.
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Impresion de Imagenes
MonitorCEC permite imprimir las graficas visualizadas. Para realizar esta accidn, presione

L1

el boton = presente en la barra de herramientas, o seleccione la opcién “Ayuda”-
>“Imprimir” en la barra de menus (ver Figura 30).

Archivo Graficar  Tools Configurar  Ayuda Graficar  Tools Confiqurar  Ayuda
S| %S ‘;ITF' 'ik;_’ kB a Guardar | 1) -k; ke

Imprimir

Salir

Manhirar Imanan Manhirar manan

Figura 30. Seleccion de la opcion de impresion.

Una vez ejecutada esta accidn, la aplicacién abrird una nueva ventana en la que se
presenta la vista preliminar, y en la cual ademas es posible seleccionar el tamafio de la
hoja, elegir impresién a color o en escala de grises, modificar el tamafio y tipo de papel,
tipo de lineas, unidades y la orientacion del papel (ver Figura 31).

Captura de Imagen

Para el almacenamiento rapido de las graficas desplegadas en la ventana principal de
MonitorCEC (densidad espectral de potencia o senal recibida en tiempo real), la aplicacion
posee un botdn denominado “Capturar Imagen”, situado en la seccién superior derecha
de la ventana, y habilitado solo una vez se ha iniciado la captura de datos a través de la
tarjeta de sonido del computador (ver Figura 32). Al ejecutar este botdn, la aplicacidn
despliega una nueva ventana en la que se presenta una instantdnea de la sefial presente
en la ventana principal. Esta grafica se puede ampliar, mover o imprimir tal como se
explicd en las secciones anteriores (ver Figura 33).
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Figura 31. Cuadro de diadlogo de impresion.

B MonitorCEC
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Figura 32. Botdn para la captura de imagenes desplegadas en la ventana principal.
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Figura 33. Captura de pantalla de la sefial desplegada en la ventana principal de
MonitorCEC.

Ayuda

La opcion “Ayuda”->"Ver Ayuda” en la barra de menus permite desplegar este documento
de guia de usuario en formato pdf (ver Figura 34). El usuario debe tener instalado en su
computador un visor para este tipo de archivos.
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Figura 34. Apertura de la guia de usuario (este documento).
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Acerca De

Al seleccionar la opcién “Ayuda”->"Acerca de Monitor CEC”, la aplicacion despliega una
ventana con informacién acerca de la version del programa, los autores y sus filiaciones
institucionales (ver Figuras 35y 36).

24 MonitorCEC =l
Archivo  Graficar  Tools  Configurar
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Figura 35. Seleccion de la opcion “Acerca De”.
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Figura 36. Acerca de MonitorCEC.
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